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10 — HOW TO KEYBOARD
PDFs
Portable Document Files (PDFs) are files with .pdf file-extension. They may contain text or
images or both but the ones that we use in WEBBS keyboarding contain only images —
images of pages of an original Bible or other document.
Our work is normally sent out in the form of PDFs as e-mail attachments but in some cases it
may be sent by post as paper copies.

How Much to Keyboard
It is important to type only the chapters allocated to you by your team leader.
The length of each PDF is usually four pages of the original text and this does not usually
amount to a whole number of Bible chapters. For example, a PDF which has a filename
bemMAT01-03a.pdf would contain about 2½ chapters, and the following one with filename
bemMAT03b-05a.pdf would contain about 2 chapters.
So, if the work allocated to you is Matthew 1-3 both those PDFs will be sent to you but you
should not type beyond the end of chapter 3. The chapters after that point will have been
allocated to someone else.
Be careful to type only those cross-references and/or footnotes (if there are any) associated
with the chapters allocated to you.

Handling PDFs on your Screen
Rotating: When you open a PDF you may find that the text is sideways on the screen. Click
on the “View” menu of your PDF reader program and then, depending on what version of
reader you have, you will see how to rotate the file — clockwise or anticlockwise — to put it
the right way up on your screen.
Enlarging a detail: One of the benefits of looking at these files on screen instead of on a
paper copy is that you can enlarge a small area to see small details. If a character is not clear
on the screen and you want to see it enlarged, position the mouse pointer over it, hold down
the ‘Ctrl’ key and use the mouse wheel. After inspecting it, return to your previous view by
again holding down the ‘Ctrl’ key with the mouse pointer over the character and turning the
mouse wheel in the other direction.

Returning Files
After checking the files for mistakes keyboarders should send them to the Team Leader within
one month. If they cannot do it within that time they should tell their Team Leader. (The
arrangements are a little different in countries other than the UK.)

Which Program to Use
Any simple word processor may be used, such as WordPad or Notepad. Microsoft Word is not
suitable as it causes difficulties even if the files are saved as “Text Only”.
Easy-KeyEdit is a word processor program developed especially for keyboarding Scripture and
related documents. It has the advantage that the correct Special Characters appear on the
screen when their replacements are typed. Also it gives the option of displaying what has been
typed in a formatted view for checking purposes. If you do not have Easy-KeyEdit and wish to
use it, contact your Team Leader (or, in America, your Co-ordinator).

Methods of Keyboarding
Different ways of keyboarding are best for different keyboarders. Each keyboarder should
choose the method best suited to his or her skills, preferences and type of computer software.
Four methods are described here:
1 Keyboarding from a hard copy
2 Split-screen working, side by side
3 Split-screen working, one above the other
4 Floating Text Entry
They are described on the assumption that Easy-KeyEdit is used but methods 1, 2 and 3 are
available with any simple word processor. Method 4 is available only when using Easy-KeyEdit.
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Hard Copy

Some keyboarders receive their work by post on paper (as “hard copy”). Others who receive it
as PDFs may prefer to print on paper from the PDFs and type from the hard copy.
If you print on paper from a PDF you can select an area to print instead of printing a whole
page at a time. You can select one page of a two-page spread, or part of one column, thus
producing larger type on the paper. To do this, select the area to be printed with the
“Snapshot” tool. This may be on the toolbar as a “camera” icon or it may be found by clicking
on “Tools” and then on “Select & Zoom”, depending on your PDF Reader.
When typing from a hard copy it is easy to miss out a line or to type a line twice. To guard
against this it is best to lay a ruler across the page as a place-holder and to move it down for
every line, or at least for every couple of lines.

2

Split Screen — Side by Side

Open the PDF of the original text and Easy-KeyEdit. If either of them fills the whole screen,
click the “Restore Down” button at the top right corner of the screen to reduce it to a window.
By dragging the top bars of the windows, or their edges, arrange them as shown.
(Alternatively, if you are using Microsoft Windows: Open the two files, first the one you want
on the right followed by the one you want on the left. Right-click on a blank area of the taskbar at the bottom of the screen. In the menu that appears, click on “Tile Windows Vertically”.)

Notice that, in the diagram, the PDF window is wider than the other. That is done so that the
size of the text is not too small. This adjustment may need to be done differently in different
projects according to the lengths of the lines of text.
When you reach the bottom of either of the two windows, scroll both files up to continue near
the top of the screen.
(If you are using Easy-KeyEdit, special characters appear correctly on the screen when their
replacements are typed.)

Checking after Keyboarding
Remember that it is essential to check the file for mistakes after it has been keyboarded.
If using Easy-KeyEdit, this may be easier to do after changing the view by clicking on the
“Formatted view” tab but in that case it is necessary, when an error is found, to change the
view back again by clicking the “Edit” tab in order to correct the error.
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Split Screen — One Above the Other

Open the PDF of the original text and Easy-KeyEdit. Position the two windows with the mouse
by dragging the top bar or the sides of the window so that they are one above the other. This
may be done with the Easy-KeyEdit window at the top, as shown in the diagram or, if you
prefer, the other way up.
(Alternatively, if you are using Microsoft Windows: Open the two files, first the one you want
to be below followed by the one you want to be above. Right-click on a blank area of the taskbar at the bottom of the screen. Then in the menu that appears, click on “Tile Windows
Horizontally”.)

In the diagram, the PDF window has been reduced in size and its text enlarged so that only a
few lines are shown. The advantage of reducing it is that each line of text is nearer either to
the top edge of the window or to its bottom edge. These two edges act as place-holders in a
similar way to a ruler laid across a paper copy, making it easier to avoid missing out a line or
typing a line twice.
This method allows the text shown on the screen to be bigger than it would be in Method 2,
Side by Side. This will be an advantage for some keyboarders, perhaps for greater legibility
but also to make it easier to return to the right spot on the screen after looking away.
When necessary, scroll the text of the PDF up either by dragging it with the mouse or by the
mouse wheel. Of course, this needs to be done more frequently if only a few lines are showing
than it would if the text size was smaller and the PDF window filled half the screen.
(If you are using Easy-KeyEdit, special characters appear correctly on the screen when their
replacements are typed.)

Checking after Keyboarding
Remember that it is essential to check the file for mistakes after it has been keyboarded.
If using Easy-KeyEdit, this may be easier to do after changing the view by clicking on the
“Formatted view” tab but in that case it is necessary, when an error is found, to change the
view back again by clicking the “Edit” tab in order to correct the error.
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Floating Text Entry

This method is only available when using Easy-KeyEdit.
● Start in the same way as for split screen working with one above the other, but the PDF
original must be above the Easy-KeyEdit window and it needs to occupy most of the screen.
● Type the \id and \id2 lines in the usual way.
● Click on the “Floating Text Entry” button. The Text Entry window will appear. Position it and
size it by dragging its edges to place it just under the first line of text (in the same way as it is
shown under the second line in the diagram).
● Type the first line of text, including SFMs. (This assumes there is no \s1 line.)
● Before going on to the next line, check carefully for typing errors and correct if necessary.
● Press “Enter”. The line you have typed disappears and appears instead in the Easy-KeyEdit
window, leaving the Text Entry window empty ready for the next line.
● Move the Text Entry window down either by dragging its top bar with the mouse or by using
the down arrow on a green square. Then type the next line. The diagram shows the position
just after the second line has been typed.

Note that \v 2 is typed in line instead of in its usual position at the beginning of the line. The
reason for this is to make the line that has been typed match the line of the original for ease
of typing and for effective checking. The Easy-KeyEdit program will put the \v SFM and the
verse number in the correct position at the beginning of a line when the file is next saved,
closed and re-opened.
In the previous line, \c 19 and \p were both typed in line. It doesn’t matter whether they
are typed that way or on separate lines because Easy-KeyEdit will adjust them as necessary.
Remember to check each line carefully as soon as you finish typing it. The fact that the typed
line and the same line in the PDF are close together on the screen makes this checking easier.
The font size shown in the Text Entry window in the diagram is 20. This is often about right. It
is easy to adjust by the control in the Text Entry window.

Checking after Keyboarding
Although careful checking of each line as it is finished may remove all actual typing errors,
other mistakes may remain. It is essential to check after the whole file has been keyboarded
for such things as errors in SFMs. Also, a line may be omitted by positioning the Text Entry
window in the wrong place on resuming work after an interval. Checking for these and other
errors after the whole file has been keyboarded is essential, perhaps using Method 3 as
described above.
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A Note About OCR
Optical Character Recognition (OCR) means the processing with specialised software of
printed characters such as those in a PDF, or else from a printed sheet by using an optical
scanner. The computer recognises the letters and other characters and produces a text file. It
has a similar effect to keyboarding the text from the file. (A PDF, Portable Document File, is a
file of a type which has a .pdf file-extension. The ones we use are pictures of pages with text
on them.)
We do not recommend OCR for the reasons set out below. If it is used then the precautionary
advice must be followed. If, as a keyboarder, you do use it, then please tell us by adding OCR
to the \id2 line of each file for which you used it, as:

\id2 [language], [your name], OCR
OCR is excellent for some purposes, like large and clear printed text in English with a simple
layout on the page, but there are some real pitfalls which, from our experience of having to
put them right later, should be avoided by careful sight-checking of the scanned text.
Some people who have an OCR program on their computer may prefer to use OCR rather than
keyboarding our files. After doing that it is of course necessary to work through the file putting
in the SFMs, and it is also necessary to check very thoroughly for errors and to correct all that
are found.
OCR usually produces numerous errors. Common ones when dealing with English script
include confusing I (upper-case i) with l (lower-case L) and 1 (numeral one); confusing
O (letter) with 0 (numeral); reading letter m as r n ; and many more. In the non-English
languages that we keyboard there is the additional problem of special characters and diacritics
which OCR cannot recognise.
The errors produced by OCR are often difficult to recognise by eye. For example, wa1k (with
numeral one as its third character) is hard to distinguish from walk (correctly spelt). Another
example is that letter o with acute accent, ó , may be read by OCR as numeral 6 which in
the fonts that we need to use may be difficult to detect.
If two keyboarders doing the same batch of text both use OCR, then the same errors are likely
to be common in both files. If they remain uncorrected, when it comes to merging and
checking the files such ‘matching’ errors will be not be picked up by the merging software.
This means they may remain wrong in the final files.
OCR may take less time to ‘capture’ text than keyboarding does but this advantage is offset by
the longer time it takes first to insert the SFMs and then to do the extra thorough checking
and correcting that is necessary. This may still save time for the keyboarder but it is our
experience in WA that some files produced by OCR have many more errors remaining when
they are sent in than keyboarded files do, and many are types of error that are more difficult
to detect. That causes delays further down the line and there is not likely to be any overall
saving of time.
For these reasons we do not recommend the use of OCR for our work.
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